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Welcome to the ColorSource Help System

The topics found in this help system can also be found on your console by pressing the =4
Tutorial videos are also available on your console.

ColorSource 20

Shutdown

Hold the Stage Map button (left-most button below the screen) for three seconds to select the Shutdown
screen.

Shutdown sends the console into hibernation mode and turns off the screen and indicators.
To awaken the console, press the now blue Stage Map button again.

. Note: When in hibernation mode, the console and its external power supply unit still consume
some power. To ensure zero power consumption, the external power supply should be dis-
connected from the AC mains supply.

\ All data is stored internally in non-volatile memory. Do not switch off the power until
any pending save operation is completed, or you may lose data. It is strongly advised that you
make periodic backups of important data to an external memory stick using the export function.

A\

It is recommended to power the unit on and off on the AC side of the external power supply.
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ColorSource Overview

The ColorSource console is made up of four different physical areas; the touchscreen (stage map), the
faders and bumps, the crossfader, and the master faders. It is important to familiarize yourself with these
different areas as you learn to use your console.

Four User-Definable Master Faders

Faders \mth Bump Buttons

f=j=i=i=i=i=imi=i=)=)

Stage Map/Shutdown Button Five User-Definable Buttons

Kensington Lock Kensington Lack

USB Port
M M MM AR ]
?/ . ColorSource 20 ® —gz
o o™ dic  iiiiille.- .
@ e v o ®
DMX Port DC Power Input

A Note about Touchscreen Performance on ColorSource Consoles

The ColorSource console touchscreen requires that the power supply is grounded (with a three-pin con-
nector) for optimal performance. Lack of a grounded connection can cause the touchscreen to operate errat-
ically or not at all. This might be seen as unwanted operations or inability to precisely select an item.

If no earthed / grounded outlet is available, or if the console is being run from an independent power source,
including from a vehicle or battery, it is possible that the touchscreen will not operate correctly. In these situ-
ations it is advised to directly connect your body to the console chassis. This may be achieved with a con-
ductive wrist strap, of the kind used in electronics manufacturing or hospitals to eliminate static charge
build-up. The cable of the strap should be attached to a metallic part of the console, for example a screw or
connector on the rear panel. If this is not practical, then you should at least ensure that you touch the con-
sole enclosure, the metallic part of it, with your wrist or your other hand.

Stage Map

The Stage Map button (left-most button below the screen) displays a topographical map of channels full-
screen at maximum size. You may select channels on the topographical stage map for control.

Note: The Stage Map button will toggle between displaying the Stage Map or the previously
selected display.
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K7 Clear
Q2

Available Controls
»* Pinch two fingers to zoom the display in or out. Zoom in to see intensity levels within the channel
cells.
# Drag with two fingers to pan the display.
7+ Single click on a deselected light to select it.
»* Single click on a selected light to deselect it.
# Double click on alight to select that light alone and de-select all others.
» Stage Map Arrange Mode
»* Selected lights are indicated surrounded by a green box.

The vertical strip to the right of the main area displays special content that is playing:

»+ Effects: press anicon to Stop or Edit the effect from playback. Press the icon to place the effect on
the wheel controller to increase or reduce the effect.

P Note: The Effects icon will only display if that type of content is playing. ]

Stage Map Arrange Mode
Press and hold a cell on the stage map, or go to Setup >Stage Map to open the arrangement screen.

When in arrangement mode, the screen displays as a grid. Press and drag lights to move them to another
position on the grid.

Arrange mode: Drag channels around and leave with Home

H 111213 14

[ ] ]
Controls

Channel
120

Playback |
1

Record/
Edit

ol

Setup

Cue List
Press the Stage Map button (left-most button below the screen) to exit the arrangement mode.
Fader Mode

The faders to the left of the display may be set to operate individual channels or playbacks.
Two pages of channels are provided and ten pages of playbacks.
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p Note: See channels for information on faders and captured channels.

Bumps
The buttons below the faders are bump buttons.
Their operation changes based on the fader mode.

#* When the faders are in channel mode, the bumps can be used to select or deselect channels.
#* When the faders are in playback mode, their behavior is set based on the selected button mode.

Crossfader

The Crossfader can be assigned to one of the four faders above the touchscreen. It is assigned in the Con-
sole tab in Settings.

The Crossfader provides manual control over the fades between cues. You can see the progress of the
crossfade and which cues are affected in the cue viewer.

Crossfader

Master Faders

Master faders can be used to control the output of certain functions. Master faders are assigned to the top
four faders. They are assigned in the Console tab in Settings.

Note: When the Playbacks or Cues faders are fully down no output will be produced by those
sections.

Master faders default to these functions:

#* Bumps: controls the output when a bump button is pressed.

* Playbacks: controls the output of the playbacks and sequences.

7+ Cues: controls the output of the cue list.

# Crossfader: Crossfades the cue list from the Live to the Next step.

v

St

In Simple Mode

** Masters 1- 4: The four playback masters. You may record the output and store it on one of the four
masters to be re-used later.
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Getting Started With Patching

To be able to control the lighting fixtures in your system you need to assign each fixture (or a group of dim-
mers) to a channel fader. The channel fader can then be used to set intensity of a fixture. The channel also
becomes a way to select that fixture for other types of control like color changes, or adjustment of other
parameters (in the case of a moving light, for example). The fixtures in your lighting system are controlled
using the DMX protocol and each dimmer or fixture uses a DMX address (or set of addresses) to com-
municate with the console.

The Patch is used to associate a channel with DMX addresses and device types. Once a channel is
patched to an address or addresses, and the output is connected to a device (for example a dimmer, mov-
ing light, or accessory), the channel will then control that device.

To access the Patch functions, press the Setup > Patch.

Note: If your patch stays the same between shows, you can save time by saving a default
show, which will load your patch automatically for you.

Patch
Displays the patching screen and controls.

Searching for RDM devices...
1 Paletta 1 ! RDM
Ch Device type Univ. DMX Tagl Tag2

1 ETC Paletta

2 ETC Paletta
3

ETC Paletta

Patch (1: ETC Paletta)
7 HEE o 10

Add dimmer Add device Remove Show Universes

Patching associates a console channel number with an address or block of addresses on the DMX output.
You must ensure that the address on the light, dimmer, or device matches the address that you setup in
Patch. To patch a basic device, press Add Dimmer.

Complex devices with several parameters, such as motion, color, or beam controls, are described by a per-
sonality. Select the make and type of device to match the actual connected device. Some devices have
modes that must also match on the device and in the patch list. Lighting devices with RDM available and
enabled are found automatically and added to the list of devices. You must still assign them to console
channel numbers though. To patch a complex device that is not automatically found by RDM, press Add
Device.

During patching you may add tags to each light, dimmer, or device to aid in convenient grouping on the
quick select screen.

The lower section of the screen may be set to display the channel stage map or a view of the DMX uni-
verses output.

The settings and patch for the independents are on the Ind. Tab in Settings.
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Add Dimmer

Dimmers are single-address devices that control intensity only. For patching multiple-address devices, see
Add Device.

Note: Dimmer patching can also be used to connect other simple devices that only require one
DMX address.

Patch Wizard
Channel  Count Universe  DMX
113

Accept

Cancel

Enter the number of dimmers to patch

Patching a Dimmer or Single-address Device

1. Press Add dimmer.This will open the Patch Wizard display.
2. Select Channel to enter the channel number.

3. Select Count to enter in the number of similar devices you are patching. If the quantity is more than
one, each dimmer will occupy one DMX address, starting from the address you specify.

4. Select DMX to enter the DMX address.
5. Select Accept to patch, or Cancel to exit.

For Example:
If you set the count to 12 and the DMX address to 20, the devices will occupy DMX addresses 20-31.

Patching places the items in a list in the upper part of the patch screen and on the topographical stage map
in the lower part of the screen in rising order starting in the top left corner. You may select one channel at a
time in the list or on the stage map.

Each channel may be edited in the boxes at the top of the screen for channel number, DMX Universe and
DMX address. You may also add tags to each item so that they may be conveniently grouped on the quick
select screen.

Duplicate Cell

Duplicate cell lets you place two dimmers on the Stage Map in different places patched to the same chan-
nel.

Note: Duplicate cell adds dimmers only and not devices. Devices must be patched and placed
individually. See Add Device.

Pick a channel in the patch list and select the + button and then the Duplicate cell button to make a copy.

Dupl'\cate

Cell

A new cell is added and is patched to the next-highest free DMX address. You may change the address
and universe and set tags in Patch.

Getting Started With Patching



When a duplicate cell is selected or operated, each of the duplicate cells on the Stage Map will respond
together. Each cell of a duplicate channel may be moved separately on the Stage Map.

Note: Youcan also add dimmers to a channel without showing them as separate cells on the
Stage Map. Use Add Dimmer and then set the channel number to be the same as the channel you
want to add the dimmer to. Dimmers added in this way do not consume space on the Stage Map,
for instance you may need one channel to control a range of dimmers for house lights without wish-
ing them to be each placed and indicated separately.

Add Device

Devices are multiple-address lights with a number of controllable parameters, such as position, color,
beam, and intensity. Devices have their own personality, which defines what each parameter does and
which controls are needed.

Patch Wizard
Channel  Count Universe  DMX
22 1 1 113

Single footprint: 1 Total footprint: 1

Elation Architectural Model
Elektralite ColorSre Linear 1
Element Labs
Elements olorSrc PAR
ColorSrc PAR Deep Blue
ColorSrc Relay
ColorSrc Relay Wireless Accept
Colorsre SPOT

ColorSrc SPOT Deep Blue Gret

Select a manufacturer and model from the scrolling lists

Note: Lighting devices with RDM available and enabled will be found automatically and added
to the list of devices in the patch. However, you must assign them to console channel numbers.

Patching a Device

1. Press Add Device. This will open the Patch Wizard display.

2. Select the correct personality from the list provided. Select the make and type of device to match
the actual connected device. Some devices have modes that must also match on the device and in
the patch list.

3. Select Channel to enter the channel number.

4. Select Count to enterin the number of similar devices you are patching. If the quantity is more than
one, each device will occupy the number of DMX addresses used by its footprint, starting from the
address you specify.

5. Select DMX to enter the starting DMX address.
6. Select Accept to patch, or Cancel to exit.

For Example:

If you patch 12 devices with a footprint of 6 DMX addresses each to address 20, they will occupy DMX
addresses 20 - 91.

To patch devices with a gap between them, adjust the Spacing value to a larger number.

Note: Do not adjust this to a smaller number as that will cause overlaps and unexpected beha-
vior from your devices.

For Example:

Getting Started With Patching



Your devices use 17 channels, but you would prefer to manually address them at logical starting nubmers
like 1, 21, 41 and so on. Use the Spacing cell to change the footprint to 20 so that those devices will auto-
matically patch at 1, 21, 41...

Patching places the items in a list in the upper part of the patch screen and on the topographical stage map
in the lower part of the screen in rising order starting in the top left corner. You may select one channel at a
time in the list or on the stage map.

Each channel may be edited in the boxes at the top of the screen for channel number, DMX Universe and
DMX address. You may also add tags to each item so that they may be conveniently grouped on the quick
select screen.

Note: Custom fixture profiles can be loaded onto the console. Please see Loading a Fixture Pro-
file for instructions.

Loading a Fixture Profile

If you have devices in your lighting system that cannot be discovered by RDM and are not included in the
onboard device library, you can create your own personality for that device and import it into your show file.
There is a device editor application for Windows PCs called ColorSource Personality Edit, which is avail-
able for download at www.etcconnect.com.

To request a fixture personality from ETC, please send your request along with the user manual, the
required mode(s) and your need by date to ColorSourceConsole@etcconnect.com.

P Note: Forthe console to recognize the profile, the file name has to be userlib.jlib. ]

1. You will need to save the file onto the root directory of a USB drive to be able to read it from the con-
sole.

2. With the USB drive plugged into the console, go to Setup>Patch>Add Device.

3. From the Source dropdown, select User Library. A new library will display with your fixture listed by
its manufacturer's name.

Note: Custom device libraries are not stored on the ColorSource console itself. Please store
these custom files on your USB drive or on another computer for safe keeping.

Remove

Select a device or dimmer, and press Remove to remove from the patch. If you accidently remove a device
or dimmer, you can use the Undo function to restore it.

Note: If you have recorded a device into playbacks or cues, and then remove it from the patch,
all the recorded values will remain in the playback or cue, but they will no longer be connected to a
device.

Show Universes / Show Stage Map

The lower section of the Patch screen may be set to display the topographical Stage Map or a chart of the
DMX addresses.

The DMX address chart is view-only and may not be edited. Scroll up and down to view all the addresses in
the selected Universe.
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1 Paletta 1 1 RDM  Identify
Ch  Device type Univ. DMX Tagl Tag2
ETC Paletta

2 Dimmer

3) ETC Paletta
Patch (1: ETC Paletta)

Universes:

1301 224| 255| zssl 255' w60l o 255|

Add dimmer Add device Remove Show Stage map

** Each cell shows the DMX address, the value in the range 0-255 and the name of the parameter if for
a device patched with a personality.

#+ Cells colored in light blue indicate the base address of the item, which is the address entered in the
Patch screen DMX box. The following cells in dark blue show the following DMX addresses used by
the device according to the size of its footprint.

»* Cells colored in green indicate single channel dimmers.

#+ Cells colored in red indicate patching overlap, where more than one dimmer or device is patched to
the same DMX address. In some cases it may be desirable to patch with overlaps but usually it is a
bad idea to be avoided if possible.

# Cells in black are unoccupied and not patched.
#* A vyellow bar graph indicates the approximate value being output.

Invert Pan

Switches the pan control to run in the opposite direction. Click on the + button in patch for the device you
want to invert pan.

Invert | Invert | Swap
Pan Tilt Pan/Tilt

Note: Use this if you have rigged a light upside-down or back-to-front compared to other similar
lights so that if they are all selected together their movements will be in similar directions.

Invert Tilt

Switches the tilt control to run in the opposite direction. Click on the + button in patch for the device you
want to invert tilt.

Invert | Invert | Swap |

=+

Pan Tilt Pan/Tilt

Note: Use this if you have rigged a light upside-down or back-to-front compared to other similar
lights so that if they are all selected together their movements will be in similar directions.

Swap Pan and Tilt

Exchanges the pan and tilt channels so that pan on the console controls tilt on the device and vice-versa.
Click on the + button in patch for the device you want to swap pan and tilt.

Invert | Invert | Swap |

Pan Tilt Pan/Tilt
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Note: Anexample of when to use this function would be if a fixture is hung sideways or a mov-
ing mirror fixture is rotated 90 or 270 degrees from other fixtures.

RDM

RDM is a two-way communications method built-in to ordinary DMX512 for lighting control. See About
RDM for more information.

The RDM button enables or disables RDM on the local DMX port. When enabled, the RDM button will be
green. If you have problems with lights or dimmers connected to the local port on the console that flicker or
suffer interference when you open the patch screen try turning off the RDM button.

. Note: When you exit the patch screen, all RDM messages are suppressed and only ordinary
DMX512 is sent to your lighting rig on the local console ports. The RDM button allows you to turn
off RDM when on the patch screen. Doing so will prevent the patch screen from finding and patch-
ing RDM lights. You should only suppress if necessary to prevent flicker or errors on the local con-
sole port(s) while you are in the patch screen.

(. J

. Note: Youmay also choose to turn off RDM when you have patched all the lights in a rig that
you wish to use. If the rig contains lights that you do not wish to patch, they will keep appearing in
the patch list, awaiting a channel number, and you can prevent this from being an annoyance by
turning off the RDM button.

. J

Identify

Identify finds the RDM-capable lights during patching so it is easy to know which device is which when
assigning them to channels.

P Note: Identify does not work with non-RDM devices or dimmers. ]

When RDM discovers a light, the light is placed at the top of the patch list with the channel shown as zero.
When ldentify is set to On, each light selected in the patch list will identify itself exclusively, usually a light
will blink on and off. Devices that do not produce light, for example a scroller or pan/tilt yoke, may shuffle or
move. The action that a light does when told to Identify is determined by the its manufacturer.

You will need to choose a channel to patch the device.
Turn off Identify to stop all RDM Identification. Turn on Identify to see the currently selected RDM device.

About RDM

RDM is a two-way communications method built-in to ordinary DMX512 for lighting control. By using RDM,
you can find lights, find out about them and their status, patch them, and set their operating mode without
needing to go to the light itself. For lights rigged in difficult locations, RDM is very useful for remote setup.

Discovery

RDM automatically discovers RDM-capable lights. Discovery runs continuously any time the Patch
screen is open and the RDM button is enabled, and will repeatedly search for devices. As devices are
added or removed from a system, they will be updated in the patch list.

Note: Discovery takes place during short periods of rest of normal DMX transmission and is a
lengthy process to complete. You should expect at least several seconds of delay to discover a
light on a small system and much longer delays on a very large system.

Addressing and Mode
RDM allows you to set the DMX address and the operating mode of a light remotely.
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Setting the operating mode may change the footprint, which is the number of DMX addresses occupied by
the device. If you change the mode of a device adjacent to some other device or dimmers in patch, the new
mode could be larger than the available space and overlap already used DMX addresses. When this hap-
pens, the affected channels are indicated in the patch list in red, and you will need to take corrective action
and re-patch.

The Patch system knows how to match the chosen mode with the correct personality.

Universe

You cannot change the Universe part of the DMX patch for a Device found by RDM. RDM can only operate
on the one universe it is connected to. To change the universe a light is patched to, you must physically re-
plug the light to another DMX cable.

Getting Started With Patching



Getting Started With Patching



Controlling Your Lighting System

After you have completed your patch, you are now ready to start controlling your lighting system. Your
ColorSource console gives you many options for controlling of your lights.

This section discusses how to control your channels, and how to set the parameters.

Note: Depending on the types of lights you have patched, you may have additional parameters
that you can control. Those parameters may include color, position (focus), beam, and lamp com-
mands.

Channels

A channel is the control used by the console to operate a dimmer, a group of dimmers, a dimmer and a
device, or a complete moving light fixture.

Channels need to be associated with an address in patch for there to be output.
Channel Counts

?* The ColorSource 20 can control up to 20 channels in simple mode, and 40 in complete.
#+ The ColorSource 40 can control up to 40 channels in simple mode, and 80 in complete.

Setting the Operating Mode

?* Choose Simple or Complete mode on the Setup>Settings>Basic screen.

Fader Pages
#+ Simple Mode offers one page of faders to control the first 20 or 40 channels, depending on the
model.

#* Complete Mode offers two pages of faders to control all the available channels, 40 or 80 depending
on the model.

Working with Dimmers / Intensity
Channels can be controlled in several different ways:

# The faders, when in channel mode, can be used to control a channel's intensity.
Depending on the chosen operating mode: Complete or Simple, there are one or two pages of chan-
nels that the faders can control. In Complete Mode toggle the Channel button to access each of the
pages.

Note: The second page of channels is only available when channels have been patched
on that page (above 21 or 41, depending on the console model).

** You can use the touchscreen and select channels directly on the stage map. The wheel can then be
used to assign an intensity level.

# In complete mode, you can use the keypad to select a channel and assign an intensity level.

#* In complete mode, channels can also be controlled by the playbacks, sequences, and cues. In
simple mode, channels can be controlled by four playbacks.

Selected Channels

To make changes to channel values, a channel must be selected. Selection is indicated by a thick green
border around the channel cell on the Stage Map and a lit LED beneath the channel fader. Selection can hap-
pen in a number of ways:

Controlling Your Lighting System
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#* Move a fader to select a channel. If the channel is already on due to playback, move the fader until it
matches the channel's current output. Move the fader back to the bottom "zero" position to deselect
it (and take its intensity to zero.)

#+ Touch the channel cell on the Stage Map. Touch the cell again to deselect it.
# Use the Keypad to type in the channel numbers and set levels.
# To deselect all selected channels, use Clear>Selection.

Captured Channels

Selected channels that have a manually set intensity level are considered "captured.” This means that the
selected channels' levels will be held until the channels are deselected or the manual intensity values are
cleared.

If Clear>Channels is used, cleared manual intensity values will return to the levels coming from active
playback sources immediately.

If manually set channels are simply deselected, manually set levels will remain on stage until those chan-
nels get a new move instruction from a playback source.

Note: A channel fader moved back to the bottom (or "zero") position will deselect that channel.
You cannot hold a channel at zero intensity using a channel fader. Another selection method must
be used.

Controls
Controls contain all the functions for controlling lights and cues, and setting color and other parameters:

#  Stage Map: The 'home' view of the full topographical stage map.

7 Color Selector: Selection of mixable colors using a color picker or color chips.
¥+ Param: Parameter control for moving or automated lights.

#  Cue List: The cue display.

#  Playback Toy: A screen to launch lighting looks and play, or busk, live.

# Keypad: Classic level control by typing numbers.

7 Quick Select: Selection of channels in useful blocks or sets.

»  Effects: Lighting effects for color, intensity, and movement.

Note: The options, Color Selector and Param, are only available if you have patched lights
with those capabilities.

Quick Select

In the quick select display, you can pick groups of channels according to their position on the topographical
stage map or by choosing the tags setup during patching.

Controlling Your Lighting System



Controls

Channel
1-20

Playback |
1

Quick select

7 8

Record/ » 2
Edit 3 —

* ) 5 R | Clear

ey 8 6 K

Cue List [z

Groups display in the upper section, and the lower section of the screen displays the channel stage map.
Available groups are displayed in green boxes. Double click on a group to select only the lights in that
group, click on other groups to add or subtract channels from the selection.

While in the quick select display, the wheel operates the level of the selected channels proportionally. The
group buttons are also variable cells that may be wiped up and down to alter the value.

When you exit the quick select display, the channels will remain selected and colors or other parameters
may be applied to them.

Wheel

To the right of the stage map is the wheel. The wheel can be used to control channel levels by moving the
wheel up to increase the level or down to decrease.

The wheel can also be used to control depth of effects and sequence rate.

Keypad

The keypad is opened by going to Controls>Keypad. This provides classic lighting control of channels
and levels via a numeric keypad entry.

p Note: Colors, Effects, and Parameter settings must be controlled on their respective screens. ]

Available Buttons

»  +(Plus)

#» - (Minus)

b m

» Full

b @M

#» _.<<..(Backspace)
» Enter

Keypad, Plus

Adds a channel to the selection set.

For Example:
1 Thru 10 + 20 Enter - creates a set of eleven channels: 1-10 plus 20.
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Keypad, Minus
Removes a channel from the selection set.

For Example:
1 Thru 10 - 7 Enter - creates a set of nine channels: 1-6 plus 8-10.

Keypad, Thru

Selects arange of channels.

For Example:
1 Thru 10 Enter - creates a set of ten channels: 1-10.

Keypad, Full
Sets the selected channels to full intensity.
To apply the chosen intensity, you must complete the command with the Enter key.

For Example:
1 @ Full Enter - sets channel one to full intensity.

Keypad, @ (at level)
Sets the selected channels to a level specified in percent % from 0 to 100.
To apply the chosen intensity, you must complete the command with the Enter key.

For Example:
1+ 5 @ 70 Enter - sets channels one and five to 70% intensity.

Keypad, << (Backspace)
The << key behaves as a backspace button for the command line.

Controlling Parameters

Depending on the types of lights you have patched, you may have additional parameters that you can con-
trol. Those parameters may include color, position (focus), beam, and lamp commands.

Color Selector .]

Lights that have a color mixing system may be operated from this screen. If no such lights are patched, this
option will only be available at the bottom of the stage map.

Lights must be selected before a color choice can be applied to them. Select some lights on the stage map
view, or with the bump buttons if the fader mode is set to channels, and then pick a color or try several col-
ors.

Note: Not all color mixing systems can produce precise color matches and a full range of col-
ors. It is advisable to control color on only one fixture type at a time.

For lights with fixed ranges of preset colors, such as color wheels or scrollers, use the parameter control
screen.

Color Controls
Two methods are provided:
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7+ Color Chips- A set of preset color chips. Color chips may be programmed to carry any color mix.
See Setup Color Chips for more information.

#+ Color Picker- A diagram of the visible spectrum varying by hue from left to right and by saturation
(paleness) from top to bottom. A black dot is used to indicate the color selected. Press Fine to put
the color picker in fine mode. When in fine mode a box appears that may be dragged around with
finer resolution.

»* White- Anywhere on the bottom edge picks the color white. The actual shade of white pro-

duced will depend on the type of light and its capabilities.
Lights made by ETC that are set to 'Direct mode' will produce the color 'D50' - equivalent to a
color temperature of 5005K.
For ETC lights operating in other modes you should set the color temp close to 5005K on the
light so that they will match ETC lights running in Direct Mode. Other manufacturer's lights
may need to be adjusted separately.

Move the zoom box around to fine tune or click outside to select another color

Controls

Channel
1-20

Playback |
1

Color (8 ETC Paletta)
9 10

Note: Not all color mixing systems can produce precise color matches and a full range of col-
ors. Itis advisable to control color on only one fixture type at a time.

You may find it necessary to pick colors independently for different lights in order that they all produce a
similar color.

Setup Color Chips

Color chips may be programmed to carry any color mix.

How to Program a Color Chip
1. Press the Setup Chip button.
2. Pick a chip to re-program.
3. Switch to the continuous color picker display, the top right button next to the color chips.
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4. Pick a color, move around until you find the one you require.
5. Select Exit setup to close the function and save the new chip.

Note: Not all lights can produce all colors, and not all lights can match colors accurately, either
between similar models or with other different models.

You may find it convenient to make several similar chips for different lights in order that they all
produce a similar color.

Parameter

All the controllable features of an automated light, with the exception of the intensity and the color mixing,
are known as the parameters of the light.

Parameters may include position (pan/tilt), beam control (iris, focus, et cetera), or fixed-choice colors. The
tab along the top allows viewing of all parameters or only the position or beam parameter types.
= = b All [E

Channel . i
120 |128 g per Light Rad 255 0

Playback
‘fl Mo

Parameter (15 ETC Revolution Wybron Scroller)

9 |10 112 | 13 | 14

Cue List

Each cell on the parameter display is a controllable button to alter the value. Press and hold on the cell and
you can wipe the value up and down, using the entire screen height for control.

Press once and release on a cell to reveal a filmstrip-style view of the available settings, with diagrams of
gobos and samples of fixed colors. The strip may be scrolled left-right until the desired setting is found.
Pick the setting to close the filmstrip.

(Opmb 0 Light W 25 1

Parameter, All
Shows all the available parameters.

P Note: The Param button is only present if you have patched lights with those capabilities. ]
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All Position
Controls

1 11
Channel . .\ . g
1-20 128 128 ] (Oper, 0 Light Rad 255

Playback |
1 0 255

Parameter (15 ETC Revolution Wybron Scroller)
9 10 11 12 13 14

Cue List

Controls the parameters of the selected light(s). Only lights with parameters may be controlled here.

Pick a parameter and swipe the value box up and down to change values. A green arrow will appear on the
value box when you are swiping it.

Pick the value box with one press to open a filmstrip view of the available settings.

The filmstrip may be scrolled left <> right to see all the choices.

Parameter, Beam

Shows only the beam parameters. All parameters that are not position, intensity or color mixing are
included in the beam parameter set.

p Note: The Param button is only present if you have patched lights with those capabilities.

1] .
T All Position

Controls
1 7
Gen [(¢] 1] (o] 255 24 0
120 per ran%

Playback |
1

Parameter (15: ETC Revolution Wybron Scroller)
8 9 10 1 12 13 14

Record/ )
Edit

x,

Setup

Controls the parameters of the selected light(s). Only lights with parameters may be controlled here.
Pick a parameter and wipe the value box up and down to change values.

Beam
Timing 1 0Os 2 0s 3 0s 4 0s 5 0Os 6 Os ? Os

[Opmb 0 Light W 25 1
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Pick the value box with one press to open a filmstrip view of the available settings. The filmstrip may be
scrolled left <> right to see all the choices.

Parameter, Position
Show only the position parameters, pan and tilt.

p Note: The Param button is only present if you have patched lights with those capabilities. ]

L} o
Al Position

um )
Controls

Channel
1-20

Playback |
1

Parameter (15: ETC Revolution Wybron Scroller)

9 110 1 12 | 13 | 14

Cue List

Control the parameters of the selected light(s). Only lights with parameters may be controlled here.
Pick a parameter and wipe the value box up and down to change values.

Focus 1 2 3 4 5 6 7
Speed 1.0s 2.0s 3.0s 4.0s 5.0s 6.0s 7.0s
128 12 1]

Pick the value box with one press to open a filmstrip view of the available settings. The filmstrip may be
scrolled left <> right to see all the choices.

Parameter, Lamp Commands
Click on the Lamp Cmds button to see the following options for lamp control:
# Lamp On: Turns on the fixture's lamp. Also known as striking the lamp.

2+ Lamp Off: Turns off the fixture's lamp. Also known as dousing the lamp.
** Reset: Resets the lamp commands.

Parameter, Home

Sends all parameters of the selected lights to their home positions. The home positions are pre-recorded in
the patching personality files, and may not be changed by the user.

Generally, parameters home to useful settings. For instance, pan and tilt will be set to mid-way values.
Gobos and beam control will be set so that the beam is unobstructed and visible.
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Recording Your Looks For Playback

This sections covers the multiple ways that you can record lighting looks for playing back. You can record
cues, playbacks, and sequences.

#* A playback memory can contain one lighting look .

# A cueis arecorded stage look that can include channel settings for intensity and other parameters,
and effects.

# Sequences play back on the playback faders. A sequence may contain up to 99 steps with fade and
step timing.

Record / Edit
All recording and editing is performed here.
Edit

Playback |Playback Erase Update | Update

Record/ Cue [ is
2t Cue list Seq list playback B live cue |seq step

Edit Memory Seq

The following options are available:

Record

% Cue
» Playback Memory
» Playback Sequence

Edit
» Cue List

¥ Sequence List

» Erase Playback
» Update live cue

#* Update Sequence Step (only displays when a step needs to be updated.)

Recordings are made by capturing the output being sent to the stage. You may choose which parts of the
scene to record using Include Options. If you do not specify the Include Options, only lights set to an intens-
ity above zero will be recorded.

In Simple Mode
Recordings are made by capturing the output being sent to the stage.
Pick one of the four Memory Master faders above the screen to record to.
Recorded faders are indicated in Mauve color.

To edit an existing memory raise its master so that it plays on stage then make some changes using the
channel faders, the color picker, parameters or the keypad, then re-record to the same master position.

Playbacks

The faders can operate the levels of the playbacks. Playbacks can contain one lighting look, or they can
contain a sequence, which is made up of multiple lighting looks. Playbacks are mixed with Highest-Takes-
Precedence (HTP) for both intensity and color. HTP means that the highest level of all sources will be
used.

If two playbacks are up and contain the same channels with differing colors, the resulting color will be the
combination of the two. For example, if one playback has a channel set to green and another playback has
the same light set to red, when they are mixed the light will tumn yellow.

Recording Your Looks For Playback
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When playbacks also carry parameter values for automated lights, parameters may be run up or down on a
playback fader until another playback or cue takes control of them.

There are 10 pages of playbacks. If the page is changed, playbacks that are currently up will not change
immediately to the new page and must be brought first to zero. Playback faders may also carry sequences
of up to 99 timed steps.

Page 10 is a special case. It may be used in the same way as other pages, or it can be used as a temporary
store for remote recordings. Each time a remote recording is requested, the entire output state is stored as
a snapshot to a playback on page ten and the snapshot counter is incremented. If more than 20 (40) record-
ings are made, the counter rolls round to playback #1.

Simple static playbacks are shown in mauve on the bump button, sequences are shown in yellow on the
button.

1 p 3

The playbacks are all controlled by the playbacks master fader.

Record Playback Memory

To record a playback, select Record Playback Memory and then pick a bump button. A playback memory
can contain one lighting look.

To record on a different page select a new Playback Page before pressing the bump.

To choose which lights are recorded, select Include Options and pick Selected, Active or All. The default
if you do not choose is Active; only lights currently on at a level will be recorded.

When a playback recording is complete, the playback page will revert to its previous setting.

Playbacks may be named and given a time. The names and times may be viewed and edited in the Play-
back Toy screen.

To clear a playback, use the Erase Playback button under Record/Edit.

Include Options

When recording to a playback, cue, or sequence step, you may specify which lighting channels, and sets
of are included in the recording by pressing the Include Options button.

Channels:

# Active: Only channels with an intensity above zero are included.

7+ Selected: Only channels currently selected (surrounded by a green box on the stage map or brightly
lit on the bumps) are included.

» All: All channels are included.
Include:

#* Intensity / Color: Only the intensity and color mixing channels are included.
** Position: Only the position (pan/tilt) channels are included.
#+ Beam: Only the beam channels are included (beam includes non-fadable colors such as wheels and
scrollers).
Select Page
Playbacks can be arranged on 10 different pages. In normal use, all the playbacks are on the same page.
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You can arrange the content of pages to match songs, scenes, or other blocks of activity in your show by
using Select Page to record playbacks to a different page. Press the Playback button to display the Select
Page button.

When the page is changed, any playback currently set to a level will remain as it is until it is taken to zero.

When a playback arrives at zero, the page will be updated for that playback. The next time the fader is
taken up, it will operate the playback on the newly selected page.

Playbacks may also be operated on the Playback Toy screen.

Erase Playback

To remove content from a playback, press Erase Playback and then pick the bump. You will be asked to
confirm your choice. Press Yes to clear or No to cancel. The content of the playback is not simply cleared
from the output, it is completely erased.

If you accidently delete a playback, you can immediately use Undo to bring it back.

Button Mode
The buttons below the faders may be used as bumps to operate playbacks.

Note: When the faders are in channel mode, the bump button below the fader is always used to
select the channel.

Flash

Note: The button modes; Flash, Solo, Solo Change, and Move/GO are only available when the
faders mode is set to playbacks.

When the button mode is set to Flash, pressing the bump button for a playback will cause the channels in
that playback to flash on to the level of the bumps master. The color on each channel of the selected play-
back will be mixed onto the output with Highest-Takes-Precedence.

Note: Operating the Flash button is the same as if the playback fader had been taken to the
same level as the bumps master.

Solo

When the button mode is set to Solo, pressing the bump button for a playback will cause the channels in
that playback to flash on and all the output from other playbacks or the cue list will be set to zero. The
intensity will be set to the level on the bumps master and the color of the selected playback will be sent to
the output.

Note: This is the same as if the playback fader had been taken to the same level as the bumps
master and all other playbacks and cues set to zero.

Solo Change

When the button mode is set to Solo Change, pressing the bump button for a playback will cause the chan-
nels in that playback to flash on depending on the intensity of each channel in the chosen playback.
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If the chosen playback's channel is at an intensity above zero all the output from other playbacks or the cue.

list, for that channel, will be overridden. The intensity will be set to the level of the bumps master, and the
color of the selected playback will be sent to the output, for that channel.

If the chosen playback's channel is at an intensity of zero, all the output from other playbacks or the cue
list, for that channel, will be left unaffected.

Solo Change allows parts of the scene to be replaced while other parts are left unaffected.

Move /GO

When the button mode is set to Move/GO, pressing the bump button for a playback will cause the para-
meters of the channels in the chosen playback to move to their recorded positions and values, while the
intensity remains unaffected. The intensity may be operated independently on the playback fader.

p Note: Move/GO does not work with sequences. ]

Record Cue

Records the current state into a cue in the cue list. A cue is a recorded stage look that can include channel
settings for intensity and other parameters, and effects. All recording operations use the output currently
live on stage. Blind recording is not permitted.

= * 3.0
@ Bumps Playbacks Cues Crossfader 10

Edit the step parameters, a Store button to proceed or Cancel to abort
4.0 1.0 1.0 0.0

)
2.0
3.0
| 40

Cue list (record)
7 8

Include options

You may make a simple recording by just choosing Store. To specify a recording in more detail, select
Include options and choose the lights and parameters you wish to be included.

Channels: (@) Active Selected All
Include: | Position

Include options Store

Each cue may be named, and its In, Out and Wait times set.

Note: The wait time commences at the start of the cue. If wait is shorter than either in or out,
the in or out will not complete before the next cue starts.

Wait time = O is a special case and causes the cue to wait for a manual press of the GO button.

Include Options

When recording to a playback, cue, or sequence step, you may specify which lighting channels, and sets
of are included in the recording by pressing the Include Options button.

Channels:
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2+ Active: Only channels with an intensity above zero are included.

7+ Selected: Only channels currently selected (surrounded by a green box on the stage map or brightly
lit on the bumps) are included.

»»  All: All channels are included.
Include:

»* Intensity / Color: Only the intensity and color mixing channels are included.
7+ Position: Only the position (pan/tilt) channels are included.
#* Beam: Only the beam channels are included (beam includes non-fadable colors such as wheels and

scrollers).
Store

The current lighting levels will be stored in the selected cue or sequence step and recording will be com-
pleted. The recording mode is then closed, and normal operation resumes.

Note: Onceacueis recorded, it is placed on the live side of the cue crossfader and sent to the
output. To remove the newly made cue take the cues master down. The cues master allows cues
to be made as changes (deltas) by leaving it up and making the necessary adjustments for each
cue, or to be made as complete new states for each cue by leaving the cues master down and
making a new state for each recording.

Cue List
A list of timed cues.

1.0
2.0
3.0
4.0

Cue list
7. 89|10

Cues are Played back with the Cue Transport ( “ ) buttons or by moving

the crossfader up and down.

The Cue Transport buttons are Back, Pause, and GO. These buttons may be assigned to the hard buttons
below the screen, and are also always available by pressing on the cue viewer in the upper right corner.

The live and next cues are indicated on the main cue list and also on the small cue viewer (
4.0
5.0 I ) in the upper right comner.

Cues are played back through the cues fader.

P Note: Forthe cues to be seen on stage, the cues fader must be up. ]

More

Pressing on the More button in the Cue List or Edit Cue List displays will allow access to the following
options:

Next JPrevious Goto
|
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» Flag
7 Nextflag

» Previous flag
» Goto O
» Goto Cue

Flag
Cues may have aflag attached to aid in cue list navigation. Typically flags are useful to repeatedly return to

the same place in the list, for example during rehearsals.
Press Flag to place a flag on the current live cue. Press Flag again to remove a flag on the current cue.

P Note: The placing and removal of a flag is a toggle action on the current live cue. ]

Next Flag
Advances to the next flagged cue in the cue list.

Previous Flag
Returns to the previous flagged cue in the cue list.

Goto Cue
Allows you to go to a specified cue in the cue list.
In the cue list window, press More and then Goto Cue, type in the cue number, and press Enter.

Next JPrevious Goto
|

Goto 0
Cue 0 does not exist as areal cue. It is an imaginary cue before the first cue.

Press Goto 0 to take all levels from the cue list to zero, and prepare the crossfader for the first cue.

Edit Cue List

The Edit Cue List option is available by pressing the Record/Edit button and then selecting Cue List. This
opens the cue list editor. Here you may change cue names and the timing of fades. You can insert new
cues, copy cues, delete cues, and edit cues. To edit the content of an existing cue, press Edit Cue. Pick
the cue you want to edit in the cue list in the upper part of the display.

Edit times and names. To edit content, press Edit cue

Controls

Channel
1-20

Record/

e

Enter

New cue Copy cue Delete cue Edit cue
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New Cue

Inserts a new cue. The new cue is added to the next free whole-numbered cue at the end of the cue list.
The new cue may then be given another number, including a fractional or 'point' number.

For example, to insert a cue between cues 4 and 5, you would enter 4.5.

p Note: The cue listis not re-numbered when a cue is inserted. ]

Copy Cue

Copies the selected cue and creates a new cue. The new cue is added to the next free whole-numbered
cue at the end of the cue list. The new cue may then be given another number, including a fractional or
'point’ number.

For example, to insert a cue between cues 4 and 5, you would enter 4.5.

P Note: The cuellistis not re-numbered when a cue is inserted. ]

Delete Cue

Deletes the selected cue.
The cue list will not be re-numbered, and the missing cue will be skipped the next time the list is played.

Note: A deleted cue may be recovered if Undo is pressed immediately after the deletion is per- }
formed.

Edit Cue

Pressing Edit Cue will cause only the content in the selected cue to be live on-stage. Any playbacks,
sequences, or manual channel levels that are not part of the selected cue will be suppressed while in Edit

Cue mode.

Use the normal channel controls to adjust the contents of the cue live on stage. Blind editing is not per-
mitted.

@ If the selected cue contains a blackout, the stage will go dark. ]

Pick the cue you want to edit in the cue list in the upper part of the display. You can alsoinsert a new cue,
copy cue, and delete cue.

Edit Cue is a mode which takes over the console and screen. While inside the edit screen, you may visit
other screens to change colors, parameters, and effects of the cue you are editing. While in those screens,
a green watermark will display showing what cue you are editing.

Edit: Parameter
L 1] | 5 |
11

Press Store to save the current look to the selected cue and to exit the edit mode, or press Store & Next
to save your current cue and move directly to the next cue in edit mode.

Update Live Cue

Records the current state of the channels to the live cue in the cue list. The cue's previous content will be
replaced.

All recording operations use the output currently live on stage. Blind recording is not permitted.
Use Update Live Cue to quickly change or edit the cue on stage.
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Clear Cues
Clears the output from the cue list. The action is the same as taking the cues fader to zero.

Note: The cuelist position is not affected. Pressing GO will fade in the next cue after the one
that was cleared.

Record Sequence
Sequences play back on the playback faders. A sequence may contain up to 99 steps with fade and step
timing.

Select the bump button of the playback to which you want to record the sequence. If a sequence already
exists in that position, you may add steps to it, they will be added to the end of the existing sequence.

Each step of a sequence may contain channels and parameters. To choose which channels and para-
meters are recorded for each step, select Include Options.

Sequence recording is a mode which takes over the screen. The recording mode is shown by a red sur-
round to the screen.

Edit the step paramelers, a Store button to proceed or Cancel to abort

- |

Controls

Channel
1-20 ‘ 1.0

Playback |
1

Sequence (record)
7 .8/9

Record/ |
Edit

x

Setup 17 8 19

Store & Exit Store & New Include options

While in the recording mode you may visit other screens to set colors, parameters ,andeffects. While in
those screens, a red watermark will be displayed showing what step you are editing.

Parameter

To return to the main recording screen press Record / Edit again. You may store the step you have made
and exit immediately with Store & Exit or you may store the step and remain inside sequence recording to
record further steps with Store & New. Press Cancel to leave the recording screen without saving any-
thing.

Include Options

When recording to a playback, cue, or sequence step, you may specify which lighting channels, and sets
of are included in the recording by pressing the Include Options button.

Channels:

#* Active: Only channels with an intensity above zero are included.

# Selected: Only channels currently selected (surrounded by a green box on the stage map or brightly
lit on the bumps) are included.

7 All: All channels are included.

Include:
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7+ Intensity / Color: Only the intensity and color mixing channels are included.
#* Position: Only the position (pan/tilt) channels are included.
# Beam: Only the beam channels are included (beam includes non-fadable colors such as wheels and
scrollers).
Store
The current lighting levels will be stored in the selected cue or sequence step and recording will be com-
pleted. The recording mode is then closed, and normal operation resumes.
Edit Sequence List

This option opens the Sequence List editor where you can change the content of a sequence list. Press a
bump to select which sequence to edit.

Here you may change the step names and fade times. Using the Edit Step button, you may change the
content of the steps. Pick the step you want to edit in the sequence list in the upper part of the display. You
can also insert new steps, copy steps, delete steps, and edit steps.

@ * 4.0 I

Bumps Playbacks Cues Crossfader

Edit times and names. To edit content, press Edit step

1.0 1.0 1.0 More Undo
Controls

Channel
1-20

Playback
1

Cancel Enter

17

New step Copy step Delete step Edit step

Press Exit to leave the editing mode. Any changes made will be stored in the selected sequence.
New Step

Inserts a new sequence step. The new step is added to the next free whole-numbered step at the end of the
sequence list. The new step may then be given another number, including a fractional or 'point’ number.

For example, to insert a step between steps 4 and 5, you would enter 4.5.

p Note: The sequence list is not re-numbered when a step is inserted. ]

Copy Step

Copies the selected step and creates a new step. The new step is added to the next free whole-numbered
step at the end of the sequence list. The new step may then be given another number, including a fractional
or 'point' number.

For example, to insert a step between steps 4 and 5, you would enter 4.5.

p Note: The sequence list is not re-numbered when a step is inserted. ]

Delete Step

Deletes the selected step.
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The sequence list will not be re-numbered, and the missing step will be skipped the next time the list is
played.

P Note: A deleted step may be recovered if Undo is pressed immediately after the deletion is per- }
formed.

Edit Step

Pressing Edit Step will cause only the content in the selected step to be live on-stage. Any playbacks,
cues, or manual channel levels that are not part of the selected step will be suppressed while in Edit Step
mode.

Use the normal channel controls to adjust the contents of the step live on stage. Blind editing is not per-
mitted.

@ If the selected step contains a blackout, the stage will go dark. ]

Pick the step you want to edit in the sequence list in the upper part of the display. You can also insert a_
new step, copy step, and delete step.

Edit Step is a mode which takes over the screen. While inside the edit step screen, you may visit other
screens to change colors, parameters, and effects of the step you are editing. While in those screens, a
green watermark will display showing what step you are editing.

Edit: Parameter
L 1] | 5 |
11

Press Store to save the current look to the selected step and to exit the edit mode, or press Store & Next
to save the current look and remain in the edit mode.

Update Sequence Step

Sequences play back on the playback faders. A sequence may contain up to 99 steps with fade and step
timing. Sequences must be stopped and stepped-on to the correct step for editing in order to update a step.

Operation

b

* Select a bump for the playback you want to Stop.

** Running sequences are indicated by a yellow bump button.

* Stopped sequences are indicated by a blue bump button.

#* Stopped sequences may be advanced by pressing the blue bump button.

gt

P Note: Stopped sequences may be used as additional cue lists if required. ]

To Update a Sequence Step

1. Stop the sequence by using the Seq Run/Step button, which is accessed by pressing the playback
mode button in the Playback Toy display.

2. Use the bump button to advance to the step you wish to edit.
3. Then you may alter the lighting, and effects as required.
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4. When the edit is complete, select Update Seq Step to save the changes. Update Seq Step will dis-
play only when a step needs updating.

Edit

Playback |Playback = - = Erase Up-clat_ Updat_
3 L Cue lis Seq lis
Lalles = playback live cue seq step

Record/ = ) ’
Edit Memory Seq

5. Pick the bump of the sequence to be updated to complete the update.

p Note: There may be several stopped sequences at any given time. ]

Sequence Rate

Sequences play back on the playback faders. A sequence may contain up to 99 steps with fade and step
timing.

Playback
1

Seqg rate

Press Seq Rate and then select a bump for the playback you want to rate control.
The wheel will change to indicate rate control and the percentage of the rate will be shown on the wheel.

Sequence rate may also be viewed and altered on the playbacks page.

Sequence Run / Step Control

Sequences play back on the playback faders. A sequence may contain up to 99 steps with fade and step
timing.

The Sequence Run/Step button is located in the Playback Toy display. A Sequence Run/Step button will
display below each sequence and will only control that particular sequence. The button is a toggle that
either lets you stop a sequence so you can manually go through the steps by pressing the bump button, or it
runs through the steps automatically.

8 Q
Sequence Sequence

Run Step
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Operation

b

# Select a bump for the playback you want to stop or start.

** Running sequences are indicated by a yellow bump button.

* Stopped sequences are indicated by a blue bump button.

»* Stopped sequences may be advanced by pressing the blue bump button.

v

P Note: Stopped sequences may be used as additional cue lists if required. ]

Tap Tempo
Places the bump buttons for playbacks carrying sequences into 'Tap' mode.

Hold Tap and press the bump of a playback carrying a sequence (shown in yellow on the bump) in the
rhythm you want for the sequence rate.

Press several times until the rate is correct.
Tap can be assigned to a bottom button by going to the Console tab under Setup.

co I

Advances the cue list to the next position using the default cue times.

The next position may be the following entry in the cue list, or it may be somewhere else if you are jumping
to another cue or flag.

The live cue is displayed surrounded by a yellow box with the next cue beneath it.

Name r ( Wait Content

0.0

0.0
0.0
0.0

Press GO twice or more to rapidly advance to further cues.

pause NI

Stops the cue list at its current position. Any fades that are underway will be stopped.

Press GO to resume crossfading and running times.
Press Back to return to the previous cue.

Back“

Reverses the cue list to the previous cue using the default cue times.

The live cue is displayed surrounded by a yellow box with the next cue beneath it and the previous cue
above it.

Name r - Wait Content

0.0

0.0
0.0
0.0
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Press Back twice or more to rapidly return to previous cues.

Undo

You may Undo the most recent function that changed your show data. Undo is one level only, back to the
most recent action.

The Undo function toggles between Undo and Redo so you may flip back and forth between two recorded
items to see which one is correct before moving on.

The following actions are Undo-able:

»* Record Playback: Undo returns the previous recording for that playback

#+ Record Cue and Record Sequence: Undo returns the previous set of cues/steps made prior to the
most recent session. If several steps were recorded in one session, using Store and Next and not
leaving the sequence recording screen, Undo will restore all of them. If only one step was recorded
and recording was terminated with Store and Exit, then Undo will restore only that one step.

»» Patch: Undo will remove all changes made since opening the patch display. If several devices were

patched or altered in patch, they will all be restored to their former settings and values.

7+ Edit Cue List and Edit Seq List: Undo restores the previous cue list contents prior to the editing ses-

sion.

Note: Undo does not work inside Edit Cue or Seq List, only once exited can Undo
restore the previous list.

N

(&

@ Wa rning: Undo cannot recover all the actions you perform that might alter your show. In par-
ticular, Undo will not undo Erase functions that remove multiple items, for instance Erase Cue
List. It is strongly recommended to make frequent backups of important show data.

Recording Your Looks For Playback
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Using Effects

Using Effects

Effects are a method within ColorSource to provide dynamic, repetitive patterns to channels.

Effects

The Effects system is used to apply patterns to selected lights.

Patterns are provided for the following effect types: Color, Shape (motion), Intensity, and Parameter
effects.

Controls

Channel
1-20

Set effect parameters and select channels to operate on

Playback |
1

Record/

Edit

x

Setup

Color | Shape Intensity Param.

a Comnf Fiag Flames  FreakOut ioodVibration MHarlequin  Meadow  MissPinky  Picasso

Aqu mifield

[
Primary v Rothko

Poliock. Rainbow

20 o 128

Effect

Add effect Remove effect

How to Apply an Effect
1.

o gk wd

Select some lights.

Go to Controls>Effects

Press Add Effect.

Choose an effect type from the tab area.
Select a pattemn.

Adjust the effect settings for the desired result. The available effect settings change based on the
effect type selected.

Note: The orderin which lights are selected is relevant and will affect the behavior of the fan set-
ting.

To remove an effect, press the Remove effect button.

Effects can be stored to cues and playbacks. When effects are played back, a symbol is shown to the right
of the stage map display corresponding to each effect currently in operation. You may pick this symbol and
adjust the depth of the effect on the wheel, edit, or stopit.
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Rainbow

Stop

Edit I Undo

Effect, Color
Applies color effects to selected channels.

Note: The color effect system only works with lights capable of performing color mixing. Color
effects cannot be applied to lights with fixed colors or a choice of single colors on wheels or
scrollers.

How to Apply a Color Effect

1.

o g ks wd

Select some channels.

Go to Controls>Effects.

Press Add Effect.

Choose the color tab from the tab area.

Select a pattern.

Adjust the effect settings for the desired result.

Color | Shape Intensity Param.

Aqua Cornfield Flag Flames  FreakOut oodVibration Hardequin  Meadow  MissPinky  Picasso

Pollock Primary Rainbow Rothko

255 20 0 128

Effect Settings

b

b
bl

b

Depth- The amount that the effect deviates from the static color set on the light. When set to full,
the light follows the effect colors entirely. When set to 50%, the resulting colors will be half way
between the light's static rest-state color (the color it was before the effect was chosen), and so on.

Speed- The speed or rate that the effect runs.

Fan- The amount the effect is spread out over the selected lights. Without fan, all the lights change
together at the same time. With increasing the value of fan, the lights respond to different parts of
the effect, offset from each other.

Note: The orderin which the lights are selected will affect how they are spread-out by
the fan setting.

Chroma- The intensity of color. Chroma is currently 0-255. 127 = Normal, 0 = Paler, and 255 = Sat-
urated.

Using Effects



Using Effects

Note: Effects containing fully saturated colors, such as Rainbow, cannot be made
'more’ saturated with the Chroma control.

Running Effect Control

When effects run, anicon is displayed in the vertical area to the right of the stage map. This may be selec-
ted at any time to manipulate the effects.

Effects may be edited, removed, or reduced via the wheel control when they are playing back from play-
backs or cues.

Effect, Shape
Applies shape (motion) effects to chosen channels.

P Note: The shape effect system only works with lights capable of pan / tilt movement. ]

How to Apply a Shape Effect

1. Select some channels.

2. Goto Controls>Effects.

3. Press Add Effect.

4. Choose the shape tab from the tab area.
5. Select a pattern.

6. Adjust the effect settings for the desired result.

Color | Shape  Intensity Param.

Pentacls

Adjustments

** Depth- The amount that the effect deviates from the static position set on the light. When set to full
the light follows the shape entirely, which will be very large. When set to 50% the resulting Shape
will be half way between the light's static rest-state position (the position it was before the effect
was chosen), and so on.

7+ Speed- The speed or rate that the effect runs at.

** Fan- The amount the effect is spread-out over the selected lights. With no fan all the lights change
together at the same time. With increasing values of fan the lights respond to different parts of the
effect, offset from each other.

Note: The orderin which the lights are selected will affect how they are spread-out by
the fan setting.

** Rotation- The angle of the effect. In the zero setting, 0, the effect is played back normally. As rota-
tion is increased the shape will rotate. The effect of rotation will only be apparent on shapes with dis-
tinct edges or asymmetry. For instance, the circle effect looks the same no matter what is the
rotation setting whereas the Square effect appears as a diamond if set to 45 degrees rotation.
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b

Aspect- Shape effects may be squashed on one of their axes. This can used to fit a shape effect to
a stage area or scenic element. Positive Aspect progressively squashes the tilt axis while negative
Aspect progressively squashes the pan axis.

Running Effect Control

When effects run anicon is displayed in the vertical area to the right of the stage map. This may be selec-
ted at any time to manipulate the effects.

Effects may be edited, removed, or reduced via the wheel control when they are playing back from play-
backs or cues.

Effect, Intensity
Applies intensity effects to chosen channels.

P

Note: Intensity effects may only be applied to devices that produce light and have an intensity
control channel.

How to Apply an Intensity Effect

1.

oMb

Select some channels.

Go to Controls>Effects.

Press Add Effect.

Choose the intensity tab from the tab area.
Select a pattemn.

Adjust the effect settings for the desired result.

SellllEE .

Wocelerate  Accordion Cosine DiscoBoy Flicker lelierSkelie Lightning Metronome Marse Mountain

T

[ ¥ -uH Ll 1 L0 v
OonOff Oompa Saw Skyline Sparkle Staircase Strobe TakeFive Trampoline Wander

255 20 0

owAndFlutt

Effect Settings

b

b
bl

Depth- The amount that the effect deviates from the static intensity set on the light. When set to full
the light follows the effect entirely, and will range from zero to full. When set to 50% the resulting
effect will be half way between the light's static rest-state intensity (the brightness it was before the
effect was chosen), and so on.

Note: Fortheintensity to vary fully between zero and full you should set the rest-state
value to 50%, then the effect can both raise and lower the intensity by the full amount pos-
sible.

Speed- The speed or rate that the effect runs at.

Fan- The amount the effect is spread-out over the selected lights. With no fan all the lights change
together at the same time. With increasing values of fan the lights respond to different parts of the
effect, offset from each other.

Note: The orderin which the lights are selected will affect how they are spread-out by
the fan setting.
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Running Effect Control

When effects run anicon is displayed in the vertical area to the right of the stage map. This may be selec-
ted at any time to manipulate the effects.

Effects may be edited, removed or reduced via the wheel control when they are playing back from play-
backs or cues.

Effect, Parameter
Applies effects to particular parameters of chosen channels.

How to Apply a Parameter Effect

1.

No ok wN

Select some channels.

Go to Controls>Effects.

Press Add Effect.

Choose the parameter tab from the tab area.
Select a pattemn.

Choose the parameter to be affected, you will see the effect start.
Adjust the effect settings for the desired result.

Color  Shape Intensity -
m W A T A Ly (I (I

.A-::n:eierste Accordion Cosine DiscoBoy Flicker |eterSkelte Lightning Wetronome Maorse Mountain

o

OnOff Oompa Saw Skyline Sparkle Staircase Strobe TakeFive Trampoline Triangle

Wsaltz  Wander awA

Param. 1 P 3 4 5 6 7
Intensity | Red Green |Blue Cyan Magenta | Yellow

255 20 V]

Effect Settings

b

b
bl

Depth- The amount that the effect deviates from the static value set on that parameter of the light.
When set to full the parameter follows the effect entirely, and will range from zero to full. When set
to 50% the resulting effect will be half way between the light's static rest-state for that parameter
(the value it was before the effect was chosen), and so on.

Note: Forthe parameter to vary fully between zero and full you should set the rest-state
value to 50%, then the effect can both raise and lower the parameter value by the full
amount possible.

Speed- The speed or rate that the effect runs at.

Fan- The amount the effect is spread-out over the selected lights. With no fan all the lights change
together at the same time. With increasing values of fan the lights respond to different parts of the
effect, offset from each other.

Note: The orderin which the lights are selected will affect how they are spread-out by
the fan setting.
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Running Effect Control

When effects run anicon is displayed in the vertical area to the right of the stage map. This may be selec-
ted at any time to manipulate the effects.

Effects may be edited, removed or reduced via the wheel control when they are playing back from play-
backs or cues.

Add Effect

To use effects, select some lights and then press Add Effect. Choose an effect type in the tab area, select
a pattern, and then adjust the effect settings for the desired result.

The order that lights are selected in is relevant and affects the behavior of the Fan setting. Fan refers to the
amount the effect is spread-out over the selected channels. With no Fan all the lights change together at
the same time. With increasing values of Fan the lights respond to different parts of the effect, offset from
each other. Fan is set in the specific effect type tabs.

Several effects may be added to one device or channel and their actions will be combined, forinstance a
small circle effect may be applied as well as a large circle effect. The chosen device will then move in small
circles processing round a larger circle.

Remove Effect

Select the effect to be removed on the effect symbol shown in the vertical strip to the right of the Effect dis-
play, and press Remove Effect. From the Stage Map, select the effect to be removed on the effect symbol
shown in the vertical strip to the right of the stage map, then press Edit>Remove effect.

Rainbow
Stop Edit I Undo
3

16 il

Note: If the effect is playing from a playback or cue, you must edit that item to remove the
effect permanently.

Using Effects



Turning Lights Off

This section covers turning off your lights by using the Blackout or Clear functions.

Clear

Clear functions remove levels coming from various sections; cues, playbacks, and channels under control
of the wheel.

When Clear is pressed, the following options will be available:
2 All

7 Playbacks
» Cues

?* Channels
# Selection

Cleared levels fade back using the fade time, which may be set in the Times Tab of the Settings screen.
The default time is 0.5 seconds.

In Simple mode
Clear offers these two options:

» Channels - clears levels set on selected channels
»  Selection - clears the selection set.

Clear All

Clear All removes all levels coming from these various sections; cues, playbacks, and channels under
control of the wheel, faders, or keypad.

Clear Playbacks

Clears the output from the playbacks. The action is the same as taking each playback to zero or taking the
playbacks fader to zero.

Clear Cues

Clears the output from the cue list. The action is the same as taking the cues fader to zero.

Note: The cuelist position is not affected. Pressing GO will fade in the next cue after the one
that was cleared.

Clear Channels
Clear Channels removes all levels coming from channels under control of the wheel, faders, or keypad.

Clear Selection
Clear Selection deselects any selected channels, but their levels will remain at the current value.

Speed Clear

Speed Clear is a function that can be assigned to one of the configurable buttons under the touchscreen. It
is assigned in the Settings: Console tab.
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By pressing the Speed Clear button a certain number of times, you can perform the following clear func-
tions:

1. Deselect - pressing the speed clear button once deselects any selected channels, but their levels
will remain at the current value.

2. Clear channels - pressing the speed clear button twice removes all levels coming from channels
under control of the wheel, faders, or keypad.

3. Clear playbacks - pressing the speed clear button three times clears the output from the playbacks.
The action is the same as taking each playback to zero or taking the playbacks fader to zero.

4. Clear cues - pressing the speed clear button four times clears the output from the cue list. The
action is the same as taking the cues fader to zero.

Note: The cue position is not affected. Pressing GO will fade in the next cue after the
one that was cleared.

Blackout

Blackout sets all lighting levels to zero. The Blackout function can be assigned to one of the buttons below
the touchscreen. See Settings: Console (on page 57) for more information.

p Note: Independents can be included or excluded from the effect of Blackout. ]

When Blackout is engaged a red X appears below the light bulb icon in the control box adjacent to the Help
button.

Turning Lights Off



Special Functions

This section covers the use of the Playback Toy and Independents.
The Playback Toy is a display where you can control playbacks and sequences.
Independents can be used to control certain devices and can have special settings applied to them.

Independent
Operates the independent outputs, 1 or 2.

Independents may be used to operate on/off devices such as motors, smoke machines, cue lights et cet-
era.

Independents may be set to operate as momentary bumps or as push-on / push-off latching switches.
Independents may be set with an on-level and you may choose to include or exclude them from blackout.
The independent settings and patch are on the Ind. Tab in settings.

Playback Toy
This screen shows ten playbacks from the current playback page.
Playbacks can be viewed and operated here.

| § 2 3 a 5 [ 7 8 9
Mempry Memory Memory Memery Memory Memery Memory Sequence

¥ Run

100%

View/
Edit

Page- = Page+ 1

Playback Toy

Operation

#* Press on a top-row mauve cell to select and fade in that lighting scene.
#* Hold on top-row cell to edit its name.

** Press a mid-row blue cell to operate the parameters for that playback, turn on and off filters to
choose the parts to play-back.

#+ Press and hold a bottom-row grey cell to change the fade time.
Functions

¥ Intensity

» Parameter GO

» Time/ Rate

» Page-

» Page +
» All Filter

» Position Filter

Special Functions
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7 Beam Filter

» Effects Filter

» Range

#»  Sequence Run/Step
» View/Edit

The page number or name is shown to the right of the Page - and Page + buttons. Hold the button to
change the page name.

Intensity
Playback Toy provides a simple way to play one playback or sequence at a time with a single press.

The Intensity button, shown in mauve for playbacks and yellow for sequences, plays only the intensity part
of arecorded look. The parameter part of a look may be played independently, including from a different
look than the one chosen to play the intensity.

When a playback or sequence is chosen, the previous one is faded out and replaced with the newly-chosen
one.

1 2 3 a 5 6 7 8 9
Membry Memory Memory Memory Memory Memery Memory Sequence

¥ Run

0.0 100%

View/
Edit

Page- = Page+ 1

Playback Toy

You may mix one intensity look with another parameter look to make a new combination look.

Note: Youmay enter names for playbacks by holding the Intensity button down until a key-
board appears for name entry.

Parameter GO

Playback Toy provides a simple way to play one playback or sequence at a time with a single press. When
a playback or sequence is chosen, the previous one is faded out and replaced with the newly-chosen one.

The Parameter GO button, shown in blue, plays only the parameter part of the look. The intensity part may
be played independently, including from a different playback or sequence than the one chosen to play the
parameters.

The blue button indicates the types of parameters contained in the playback.

1 2
Memory — Memry

Special Functions



Special Functions

Parameters may be filtered so you can choose which types of parameters to play, for example you could
choose to only play the position part by turning off (filtering) the other parameters such as beam.

You may mix one intensity look with another parameter look to make a new combination look.

Time/ Rate

Playbacks may be given a fade time. When either a bump or Playback Toy Intensity button is pressed, the
intensity and parameter parts will fade in at the rate set on the Time button, shown in gray.

If the playback contains a sequence, the gray button will indicate the rate.

1 2 3 a 5 6 7 8 9
Membry Memory Memory Memory Memory Memery Memory Sequence

¥ Run

0.0 100%

View/
Edit

Page- | Page+ 1 I #
Effect

Playback Toy

Holding down the gray button will open a keypad to alter the time (for playbacks) or the Rate (for
sequences).

Playback Page Selection, Minus

Picks the playback page to switch to. There are ten pages of playbacks. The page will change for the next
time a fader is raised from the zero position or a playback is launched in Playback Toy on a mauve or blue
button.

P Note: Faders that are up at a level will not change immediately and must first be taken to zero. ]

The page number or name is shown to the right of the Page - and Page + buttons. Hold the name / num-
ber button to change it.

Playback Page Selection, Plus

Picks the playback page to switch to. There are ten pages of playbacks. The page will change for the next
time a fader is raised from the zero position or a playback is launched in Playback Toy on a mauve or blue
button.
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P Note: Faders that are up at a level will not change immediately and must first be taken to zero. ]

The page number or name is shown to the right of the Page -and Page + buttons. Hold the name / num-
ber button to change it.

Playback Page Name / Number

There are ten pages of playbacks.

The page number or name is shown to the right of the Page - and Page + buttons. Hold the name / num-
ber button to change it.

Filter, All

Filtering is useful to play parts of a playback and leave other parts unaffected. Using this method you can
play the pan/tilt part of one playback, the gobo and beam parts of a second playback, and the intensity and
color mixing parts of a third playback to make a new composite playback.

The All button toggles between all parameters on and all parameters off.
Switch off a parameter to exclude it from playback when operating the blue GO buttons.

Note: If all parameters are off, the blue GO button will not do anything. However, the mauve
intensity button can still launch the intensity and color mixing parts of the chosen playback.

Filter, Beam

Filtering is useful to play parts of a playback and leave other parts unaffected. Using this method you can
play the pan/tilt part of one playback, the gobo and beam parts of a second playback, and the intensity and
color mixing parts of a third playback to make a new composite playback.

The Beam button toggles between beam on and beam off.
Switch off beam to exclude it from playback when operating the blue GO buttons.

Note: If all parameters are off, the blue GO button will not do anything. However, the mauve
intensity button can still launch the intensity and color mixing parts of the chosen playback.

Filter, Effect

Filtering is useful to play parts of a playback and leave other parts unaffected. Using this method you can
play the pan/tilt part of one playback, the gobo and beam parts of a second playback, and the intensity and
color mixing parts of a third playback to make a new composite playback.

The Effect button toggles between effects on and effects off.
Switch off effect to exclude effects from playback when operating the blue GO buttons.

Note: ifall parameters are off, the blue GO button will not do anything. However, the mauve
intensity button can still launch the intensity and color mixing parts of the chosen playback.

Filter, Position

Filtering is useful to play parts of a playback and leave other parts unaffected. Using this method you can
play the pan/tilt part of one playback, the gobo and beam parts of a second playback, and the intensity and
color mixing parts of a third playback to make a new composite playback.

The Position button toggles between position on and position off.
Switch off position to exclude it from playback when operating the blue GO buttons.
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Note: If all parameters are off, the blue GO button will not do anything. However, the mauve
intensity button can still launch the intensity and color mixing parts of the chosen playback.

Range

Playback Toy displays ten playbacks at a time. To see further playbacks, press Range to switch between
them.
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System Settings and Setup

This section covers the system settings and setup options for your ColorSource console.
The following topics are covered:

S U 55
SettiNG S il 55
Settings: BasiC ... 55
Settings: TIMES ... . e 56
Settings: Independents ... 56
Settings: CONSOle .. il 57
Settings: Erase ... ... i 57
Setup
Contains functions used in the setup of the console:
» Patch
¥ Settings
» Files

» Stage Map (Arrange Mode)

Settings
All internal settings and default values are setup here.

Settings are arranged in tabs of related items:
» Basic: Operating modes, language, stage map zones, auto-select channel on fader move, and about
console information.
# Times: Times for clear, default cue, and default move.
# Independents: Independents setup and patching.
»* Console: Custom setup of console buttons and DMX speed.
# Erase: Erase operations.

Settings: Basic

From this tab you can set the operating mode and language, show zones on the stage map, and select the
fader behavior to auto-select channels.

System Settings and Setup
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Operating mode

B show Stage Map zones

B Auto-select channel on fader move

Model: ColorSource

Software version: 1.1.0 alpha 4, Boot Sim
Library version: 12.2.4

IP address: 10.8.68.183

Choose the operating mode:

»» Simple Mode: Simple mode offers a very basic set of lighting controls. There is no cue list, no fader

paging and only four playbacks. Simple mode is ideal for setting up a few static lighting states
without needing any training or deep knowledge of lighting control.

»* Complete Mode: Complete mode offer the whole set of functions and is suited to trained users and
experienced lighting professionals.

Choose the operating language. Current options are English, French, German, Japanese, Italian, Russian,
and Spanish.

Show stage map zones, when selected, will show the stage map zones. See stage map for more inform-
ation.

Behavior of faders to auto-select channels on move can be disabled here.

The hardware model, current software version, and personality library version are also displayed on this
tab.

Settings: Times
Sets the following times used as default settings for Clear and Cue programming:

#+ Clear Time: Sets the fade time for clearing channels on the Clear button.
7+ Default Cue Time: The default time for In-fade and Out-Fade in Cues and Sequences.

# Default Move Time: The time for parameters to move to new values during move dark and when
picking preset values on the Parameter screen.

Note: Move Dark happens automatically for cue playback and ensures that lights will be moved
to their correct position before the cue in which they appear is played.

Settings: Independents
Setup for the two independent control channels.

Independents may be used to control lights, for instance the house lights, or accessories and small
machines such as smoke machines or mirror balls.

In this tab, the following settings for independents can be set:

#* Universe and DMX - an independent can be assigned to a DMX address on a given universe.
#+ Level - sets the on level for the independent.
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7+ Bump - sets the bump button operation to a momentary bump or an on-off toggle.
#+ Blackout - sets whether the independent is included or excluded from blackout.

Settings: Console
Setup of the console and its buttons and faders can be done on this tab.

You can adjust the DMX speed. You should choose the fastest setting that works correctly with all your
equipment, normally with modern devices this should be Max or Fast.

You can adjust the backlight for the touchscreen and the brightness of the buttons. 1 is the dimmest setting
and 7 is the brightest.

You can assign the five right-most buttons beneath the screen to the following functions:

# None

» Back

» Blackout

» Color

» Cue List

» Effects

b @

¥ m1

» Ind2

# Keypad

» Pause

» Parameter
7 Playback Toy
» Quick Select
» Speed Clear

» Stage Map
» Tap
These buttons default to Color, Cue List, Back, Pause, GO.

p Note: The left-hand button cannot be re-assigned and always selects the Stage Map display. ]

You can also assign the four master faders above the screen to the following functions:

#» Bumps
#» Crossfader
#» Cues
# Playbacks

These buttons default to Bumps, Playbacks, Cues, and Crossfader.

Settings: Erase
The following erase operations are available in this tab:

# All: Erases all of the show data.
#* Memories: Erases all of the playback memories. To erase just one playback, use Erase Playback.
7+ Sequences: Erases all of the sequences.

System Settings and Setup
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7+ Cue List: Erases all of the cues from the cue list.
7+ Patch: Erases all of the patch.

Note: Erasing anitem removes it from the show permanently. Erasure is not the same as clear-

ing a cue or playback. A cleared item can be run again, an erased item cannot be run once
removed.
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Showfile Management

This section explains how to create, save, open, delete, import, and export show files. Software upgrades
and creating a default show file are also covered.

Files
All filing operations:

» New

¥ Open
» Save

7» SaveAs
Show files:

» Save as default

» Remove default
» Delete

¥ Import
» Export

Advanced:
# Update Firmware

» Install Extras
» Export Logs

All data is stored internally in non-volatile memory. Do not switch off the power until
any pending save operation is completed, or you may lose data. It is strongly advised that you
make periodic backups of important data to an external memory stick using the Export function.

File, New
Start a new show by going to Setup>Files>New.

Note: You will be warned that this action will clear the memory. Select Yes to clear memory
and start a new show, or No to cancel.

The new show will be based on the template default show, which is customizable.

File, Open
Open an existing show file by going to Setup>Files>Open.

Note: Show files must be in the console's internal storage before they can be opened here. If
the file is located on a memory stick, you will need to use import first.

File, Save
Save the show by going to Setup>Files>Save.

The show will be saved with the name you last gave it. If you have not yet saved the show with a name,
you will be prompted to enter a show file name.

Showfile Management
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All data is stored internally in non-volatile memory. Do not switch off the power until
any pending save operation is completed, or you may lose data. It is strongly advised that you
make periodic backups of important data to an external memory stick using the export function.

File, Save As
Save the show by going to Setup>Files>Save As. The show will be saved with the name you enter.

Note: The difference between Save and Save As is you will always be asked to name the show
file when you use Save As.

All data is stored internally in non-volatile memory. Do not switch off the power until
any pending save operation is completed, or you may lose data. It is strongly advised that you
make periodic backups of important data to an external memory stick using the Export function.

. J

File, Import
Import an existing show file by going to Setup>Files>Shows>Import.

Note: Show files must be saved on a memory stick, in a folder named "Shows" in the root dir-
ectory.

When the Import button is pressed, the following screen will display showing the available show files.
Select the desired file, and then press Accept. If you want to leave this display without importing, press
Cancel.

2.0

Bumps Playbacks Crossfader o

1] - 5

=m 1 File handling Import file
Controls
Channel L

1-20

Playback |
1

Show |
files
Flash

Record/ ) Accept
Edit

®x | current show file Cancel
Setup | maren

Cue List 1]

File, Export
Export the current show file by going to Setup>Files>Shows>Export.

Note: Show files will be saved onto a memory stick, in a folder named "Shows" in the root dir-
ectory.

When the Export button is pressed, the following screen will display. Press Yes to export. If you want to
leave this display without exporting, press No.
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File, Delete
Delete an existing show file off the console by going to Setup>Files>Shows>Delete.

When the Delete button is pressed, the following screen will display showing the available show files.
Select the desired file, and then press Accept. If you want to leave this display without deleting, press
Cancel.
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Files, Show files

You can open and save shows by going to Setup>Files

Shows are saved internally with all content, including lighting and effects.
Pressing the Show files button gives you the default show options.

When a new show is started, it will be based on the default show template, which you may define to con-
tain a patch or part-patch, some show data, including playbacks and cues, or nothing as required.

If your lighting rig is fixed and usually the same set of equipment set to the same addresses, the default
show will help you save patching and setup time. If you prefer to start with a blank state each time, no
patch and no data, then you can save an empty default show.

Functions

» Save As Default

» Remove Default Show
» Delete

#» |mport
» Export
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All data is stored internally in non-volatile memory. Do not switch off the power until
any pending save operation is completed, or you may lose data. It is strongly advised that you
make periodic backups of important data to an external memory stick using the export function.

Save As Default

The current show will be saved as the default to be used each time Setup> File > New is selected. Typ-
ically this will include a standard patch, but may also include any other show elements, for example, play-
backs for operating house lights or other standard functions.

All data is stored internally in non-volatile memory. Do not switch off the power until
any pending save operation is completed, or you may lose data. It is strongly advised that you
make periodic backups of important data to an external memory stick using the export function.

Remove Default Show
The Default show is removed to a complete blank state with no patch or content at all.
Selecting File > New will start the console with no programmed content at all.

All data is stored internally in non-volatile memory. Do not switch off the power until
any pending save operation is completed, or you may lose data. It is strongly advised that you
make periodic backups of important data to an external memory stick using the export function.

Files, Advanced
Functions

# Update firmware - updates the console's main operating software.
7 Install Extras - add or replace data files, such as new device personalities, help texts or languages.
# Export Logs - exports the console's log files to a USB drive.

All data is stored internally in non-volatile memory. Do not switch off the power until
any pending save operation is completed, or you may lose data. It is strongly advised that you
make periodic backups of important data to an external memory stick using the export function.

Update Firmware

The main operating software can be updated here. The software must be obtained from ETC and placed in
the root of the USB drive. Please make sure the software file is not inside any other folder or subdirectory,
as this will hide it from ColorSource's update function.

The file name will be in this format: ETC_CS_#.#.#.#.#.#.fw (the software version will replace #.#.#.#.#.#).

The update process may take a few minutes. Do not shutdown the console until the
process has finished. You will be prompted to shutdown the console and restart after the update.

Install Extras
Data and content used by the console may be imported here.

This includes new device personality libraries, new help texts, language revisions, additions, and other
internal features as they become available.
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The files you wish to import must be obtained from ETC and placed in the root of the USB drive. The files
will be named with the suffix .cspkg.

Note: You cannot update the main operating software here, only support files. To update the
main software version, you will need to use the Update firmware button.

Note: Fixture profiles are not loaded from this display. Please see Loading a Fixture Profile for
instructions.

Export Logs
Exports the console's log files to a USB drive. Tap Yes to export or No to cancel.
The file name will be in this format: ColorSource_Logs_#.tar.gz.

Installing Language Packs on a ColorSource Console

Any available language packs can be downloaded from the ETC website (www.etcconnect.com) as .zip
files.

1. Once downloaded, extract your file.

Place it onto the root directory of a USB drive. The file name will end with .cspkg.
Plug the USB drive into the USB port of your console.

On your console, go to Setup>Files>Advanced>Install Extras.

A list will appear that shows the files on your USB drive. Select the appropriate language file to
install.

a s wDd

S

Press Accept to begin the installation process.
7. Follow the on-screen prompts as needed.
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